Creating Posters Using PowerPoint 2013

Presented by the
Donald C. Harrison Health Sciences Library

Poster Tips ........................................................................................................................................... 2
Creating a Poster in PowerPoint 2013 .............................................................................................. 6
Poster Session Information Sheet...................................................................................................... 9

Conference poster

Objectives
Volutpat mos at neque nulla lobortis dignissim conventio, torqueo, acsi roto modo. Feugait in obruo quae ingenium tristique elit vel natu meus.

Methods
- Loquor aptent ut lorem erat feugiat pneum commodo vel obruo mara genitus.
- Suscipit, vicis prae sent erat feugait epulae, validus in doles duis enim consequat

Results
Dignissim conventio, torqueo, acsi roto modo. Feugait in obruo quae ingenium

Conclusions
Sed, conventio, aliquip accumsan adipiscing augue blandit minim abbas oppeto commoveo

References
Loquor aptent ut lorem erat feugiat pneum commodo vel obruo mara genitus

Information on the PowerPoint 2013: Creating Poster Presentations seminar can be found on the University of Cincinnati Libraries Classes & Workshops web page:
http://webcentral.uc.edu/hslclass

Prepared by Health Sciences Library (Revised 8/15) © University of Cincinnati
Poster Tips

Before Starting
- Ask the conference organizers poster size requirements.
- Here are some guidelines for poster sizes:
  - 18" x 24" for easel signs
  - 36" x 48" for small posters (used more often now)
  - 48" x 72" for large posters (not as common now)
- If you are working with a design service, contact them early to coordinate the job.
- Allow plenty of time to create the poster.
- Do not switch back and forth between a Mac and PC. Formatting problems can occur.

Page Setup
- **Always set your PowerPoint page size before you start designing the poster!**
- Consult with your printer about the best way to set up the page size. Will the printer blow it up 200% or 400%?
- The largest page size PowerPoint can accommodate is 56 inches.
- If your poster must be larger than that, design it proportionally.
  - For example for a 48" x 72" poster, set the PowerPoint page size to 24" x 36." You are designing it in half the actual size.
  - The printer will blow it up 200%, giving you a 48 x 72 inch poster in the end. This is why you must check with your printer first – see what proportion their printer can blow up. Some printers use 400%.
- If you change the size of your poster slide after you have already added content it may become distorted.

Layout
- Divide the poster into columns (3-5 across, depending on poster size).
- Use headings to identify sections.
- Avoid long stretches of text.
- Break up text with pictures, tables, figures, etc. For visual appeal and to save space, use graphics instead of text to illustrate points.
- Blank space should make up at least 35% of your poster.

Content
- Viewers should be able to scan material quickly. You have about 3 seconds to attract viewers!
- A poster is not an enlarged journal article—be brief, concise, and don’t overwhelm viewers with too much information.
- Use short sentences or bulleted text.
Standard Components

• University branding (For branding standards, go to: http://www.uc.edu/content/dam/uc/ucomm/docs/UCBrandingStandards.pdf)
• Title with authors’ names, credentials, and affiliations
• Typical headings:
  o Introduction / Objectives
  o Methods
  o Results
  o Conclusions
  o References
  o Acknowledgement of funding source if applicable

Style

• Use sans serif fonts for titles and headings (for example, Arial, Franklin Gothic, Helvetica, Tahoma, Trebuchet or Verdana).
• Some recommend serif fonts for the body text (for example: Times New Roman, Palatino) while others recommend san serif fonts. Follow requirements or use whatever is easy to read from a distance.
• Do not use all CAPS, as it is hard to read. Try to use “Sentence case.”
• Text should be legible from three to five feet away. Title font size should be about 100 points or larger and text 24 points or larger. However, font size is about judgment and what looks best with your poster.
• Graphs and tables should be large (minimum of 8.5 x 11 inches is preferable).

Colors

• Color should be used to unify the poster.
• Choose 2 or 3 colors and keep them consistent.
• Use strong, primary colors.
• Use color to highlight keywords in text. However, most text should be black.
• Backgrounds should be plain (white is a good choice). Avoid backgrounds with patterns or gradients – sometimes they do not print well.

Graphics

• Graphics can be tricky.
• Just because it looks good on the screen does not mean it will print well!
• Graphics should have a resolution of at least 300dpi.
• Try to avoid using screen shots – they are usually 72 dpi – screenshots are extremely pixilated (blurry) when printed on a large poster.
• DO NOT make graphics larger by stretching them on the screen. They will not look good. Size and resolution must be captured at origination (i.e.: scanning at a high resolution).
• Excel graphs and clip art are okay to manipulate because they are different types of graphics than digital photos or scanned images.
• Consider putting a thin border around each graphic – it makes them stand out.
Suggested Handouts
- Summary or small printout of the poster
- Copies of important figure(s)
- Business cards
- Reference list

Other Considerations
- Lamination will protect your poster.
- Prepare a 3 to 5 minute verbal description of your poster.
- Use a poster tube with your business card on the outside.
- Don’t check your poster tube as baggage when traveling to the session by plane, if possible.
- Bring pushpins and tape.
- Have a notebook and pen to write notes.
- Choose clothing colors that coordinate with your poster.
- Your poster might be freestanding – that is – don’t count on having a table.

Poster Services at UC
- DAAP Computer Graphics Center [for DAAP students-more of a rough draft]
- Art & Design Services [Poster Session Templates:]
- CECH Library
- Check with individual departments/colleges for additional options.

After the Poster is Finished...Before the Presentation
- Spend time before the session thinking about how to present the material.
  - Be able to summarize the poster’s key points and conclusion(s) in 2-3 sentences.
  - Prepare several versions of your remarks lasting from 30 seconds to 4 minutes.
  - Be able to explain the most challenging parts of the poster, especially the figures and tables.

At the Poster Session
- Remember to adjust to the audience’s changing needs—some will want explanations of the poster and others will just want to look for a short time.
- Ask your viewers what they want to know about before explaining the poster. This will save time and focus on what they really want to know and discuss.
- Spend extra time going over and explaining figures and tables.
- Listen to feedback.
- Remember to interact and network with people.
- Relax and have a good time!
Useful Websites

- UC Poster Templates. http://healthnews.uc.edu/branding/

Selected Books


Creating a Poster in PowerPoint 2013

1. **If using a template** (http://healthnews.uc.edu/branding/):
   a. Go to View Tab | Slide Master.
   b. Click on any unwanted features on the Slide Master and press “delete”
   c. Select the logo or border with logo and “cut” it out (Ctrl-X).
   d. Go to Slide Master Tab | Slide Size and then choose Custom Slide Size. You might select a height of 18 inches and a width of 24. (Blown up 200% for printing, this creates a 3x4 (36x48) poster for the printer at UC’s Art & Design Services).
   e. Paste (Ctrl-V) the logo or border back in (cutting and pasting the logo retains its proper proportions).
   f. If you want to shrink the logo, hold the shift key down while dragging the logo smaller to retain its proportions.
   g. Close Master View.

1. **If using a new, blank slide:**
   a. Go to Design Tab | Slide Size, then choose Custom Slide Size.
   b. **Important:** Find out the size values required to print the desired final finished size on the poster printer.
   c. You might select a height of 18 inches and a width of 24. (Blown up 200% for printing, this creates a 3x4 (36x48) poster for the printer at UC’s Art & Design Services).
   d. The width can be as long as 56 inches, the longest length PowerPoint can get...otherwise you have to design proportionally.
   e. See the “Tips” section for details. Be sure the slide is oriented Landscape. Then, OK.
   f. Choose Maximize in the next dialog box.

2. **To use a blank slide:** Click on the blank slide template option as PowerPoint opens. A blank title slide appears.
   a. To find an actual blank slide on the Home Tab click on the New Slide pull down menu and select the blank slide. Delete the title slide.

3. Resize task pane on left for maximum workspace. Set zoom level so that it allows you to easily view all of the slide at once. Zoom in further if you want to see a portion of the slide more clearly.

4. You can make your ruler and gridlines available so you can easily position your text boxes and graphics. View Tab | check box for Ruler and add Gridlines, and Guides if they’re helpful.

5. **TITLE:** Insert Tab | Text Group | click on Text Box. Insert the Title of your presentation across the top of the slide. Stretch box to opposite sides, then center text with Home Tab | Paragraph Group | choose Center icon. Add the author’s names and affiliations. Your title should be quite large. As a starting point, make the
title font no less than 36 points and the content font at least 24 points. The general guideline is to concentrate less on exact font sizes and more on fitting the text on the page without making it too crowded.

6. **TEXT BOX FORMATTING:** This step will let you create placeholders for text. This way you can make a layout of your poster without having every word of text prepared. Then you can go back when you are ready and add the text.

   a. Utilize the Quick Access Toolbar above the tabs in PowerPoint. Add the Text Box by going to the Insert Tab | right-click on the Text Box icon | click on add to Quick Access Toolbar. Now you will be able to quickly access the Text Box and anything else you use frequently.
   b. Click on the text box in the Quick Access Toolbar, let go of your mouse and drag the text box to the desired size using the gridlines as a guide.
   c. Use your first text box to set up formatting choices. Add a border (Drawing Tools/Format Tab | Shape Styles | Shape Outline). You may decide to remove the border later if you need more white space.
   d. Type in a heading and then hit the return key to lengthen the text box.
   e. Choose a font and sizes for the text box header and body text.
   f. When the text box is the way you want it to be, copy it and paste in the number of text boxes you want to use.

7. **LAYOUT:** Layout the text boxes where you want them. For layout, you can use the ruler and gridlines (go to View Tab | Show Group | and check Ruler and/or Gridlines and Guides).

   a. Another option is to use the alignment tool which will automatically arrange the boxes. To do so, select the text boxes (Select | Ctrl Click).
   b. Then on the Home tab | Drawing Group | Arrange | choose Align Top and/or Distribute Horizontally.

8. Once you have your text box placeholders laid out you can start adding the actual content to the text boxes. When you are all finished, you can delete the line around the text boxes, add color to the headings and/or change the font size and type.

9. **IMAGES:** To add an image, go to the Insert Tab | Images Group | Choose Picture and find the file, then, Insert. Position the image in the appropriate place.

   a. To add an Excel chart, go to the Insert tab | Text group | Object | select Create from file | browse to your Excel file | select the chart | click on OK. Resize the chart if necessary and drag to the appropriate place. Or open your Excel file | click on the desired chart | click on Copy pull down menu | select Copy as Picture | select ‘As shown when printed’ | OK. Go back to your poster in PowerPoint and paste (Ctrl V) the chart into the poster.
   b. Do NOT copy and paste images from the web. They do not have a high enough resolution.
c. But if you use Jing or another screen capture software that enables you to save the screen capture as a PNG, that will have enough resolution for printing. Jing is a free download from https://www.techsmith.com/jing.html
d. Do NOT enlarge any image, it will get blurry (other than Excel graphs and Microsoft clipart). Remember that all images must have a resolution of at least 300dpi (with the exception of Excel graphs and Microsoft clipart. Those two types of graphics should not give you problems).

10. Lines, boxes and arrows can be inserted using the Insert Tab | Illustrations Group | Shapes.

11. To print the final version on a single piece of 8.5 x 11" paper to check it over before doing the final large size, go to the Office Button | Print | Print what: Slides, and click the check box to Scale to fit paper and Frame Slides for a border around the poster (good for a cut line around final poster). OK.

12. Even though your computer screen may not be 4 x 6 feet, use your PowerPoint zoom tool to zoom in and see how your poster will print. This is especially helpful if you really want to see how the spacing between columns looks, how big fonts will be, etc. If you created a poster in 50% proportion, zoom in 200%, or if you created your poster in 25% proportion, zoom in 400%. You of course won’t be able to see the whole poster at once, but it is helpful in getting a general idea for size if you are concerned about it.
Art & Design Services
Poster Session Information Sheet
http://healthnews.uc.edu/communications/artdesign/?/posters/

**Costs:**

**Printing**
The base cost for wide format printing is $4.11 per square foot, plus a minimum production charge (for time spent) of $30.00. This means a poster measuring 4 by 8 feet (32 square feet) would cost $161.52 ($30.00 + [32 x $4.11]) to print. Similarly, a 4 by 6 foot poster (24 square feet) would cost $128.64 ($30.00 + [24 x $4.11]).

**NEW MEDIA OPTION!**
We are now able to print your posters on a polyester fabric media. The advantage is that your poster can be folded and stored in your briefcase or other carry-on instead of being rolled up and placed in a tube that will need to be either checked or fit into overhead storage. The cost of this new media is $4.97 per square foot. Contact our staff for more information.

**Laminating**
If you choose to have your poster laminated (which is recommended for the protection of the poster), there will be a charge of $1.85 per square foot. This means your 4x6 poster will cost $44.40 (24 x $1.85) to laminate, or your 4x8 poster will cost $59.20 (32 x $1.85).

**Other Charges:**

*Proof copies:* It is usually good to see a “proof” copy of your poster before it is printed. A proof is a print out of what your poster will look like when completed. When you receive a proof, you will be able to check for typos and layout errors. Proof copies are generally full color 11x17 inch prints, which cost $1.90 each. Some jobs require wide format print, which cost $4.11 per square foot.

*Production charge:* For any poster printed, there will be a minimum production charge of $30.00. This represents a half-hour of our production fee, and covers the time it takes to trim out your poster after it has been printed/laminated. If you want us to do the poster layout, there will also be a production charge for this service. Most posters can be set up in one to 1.5 hours. On average, production fees for most poster layouts are between $60 and $90.

*Tubes:* We also stock containers which will easily hold a rolled-up poster of up to 4 feet high. The charge for a cylindrical tube is $7.31.

*Scanning:* If you need any photos scanned as part of the layout, time will be billed at $11 per high-resolution scan.

*Priority Charges:* If work needs to be turned around in less than the time allotted per the project (three business days for ready files; five to seven business days for posters needing designed), there will be a priority charge applied. For a two-day turnaround, the priority charge will be 30 percent of the total amount your usual charges. For next day turnaround, the priority charge will be 50 percent. Same-day priority charges for jobs that are ready to print are 100 percent. Same-day priority jobs do not get proofs and must be submitted by 9 a.m. for 5 p.m. completion.
What we need from you:

**Poster Needs to be Designed:** If you want us to design your poster, simply e-mail your content and images to art.design@uc.edu, or drop off your data on a CD, DVD or flash drive to our office, Health Professions Building room G-44. Text can be in Microsoft Word or PowerPoint – and in either PC or Macintosh formats. Images should be submitted in high resolution (at least 300 dpi).

**Poster Already Designed:** If your poster has already been designed, just e-mail your file to art.design@uc.edu. Please note, the UC e-mail attachment limit is approximately 25MB. Larger files can be dropped off to our office, Health Professions building room G-44. We use Adobe InDesign to create our posters due to its adaptability with our printing system. You may use other programs if you prefer.

- **Tips for design:** An important aspect of poster design is setting up the aspect ratio of the page setup correctly. The document must be set up with the same width-to-height ratio you want your poster to have when it is printing, but it can be (and probably should be) set up at a percentage of the actual size. For example, our template for a 4x6-foot poster is a document that is 12 inches high and 18 inches wide. A 4x6 poster has a ratio of 1 to 1.5, so the template is set up small scale with the same 1 to 1.5 ratio. If you have questions about setting up your document correctly, please contact us so we can help you avoid time-consuming (and costly) problems.

- **Branded Poster Session Templates:** The university has made available a number of branded, poster session templates that can be downloaded free of charge. >> View Poster Session Templates [http://healthnews.uc.edu/branding/?7258/](http://healthnews.uc.edu/branding/?7258/)

- **Microsoft Publisher:** We often encounter problems with files set up in Microsoft Publisher. If you don't feel comfortable using any other program, please contact us before your begin your poster design, so we can help you avoid time-consuming (and costly) problems.

- **Saving files:** It’s important that all the files that you used to design your poster are saved on the same disk as the master file. This includes photos and graphics. This will help save time and money.

**Turnaround:**

Ready-to-print posters can usually be turned around in 3 to 4 days. This will allow time for printing you a proof copy to make sure everything still looks the way you want it to look.

Posters Needing Design Work: If we are designing your poster, the turnaround is usually between five and seven days. During this time, you will be able to proof your poster for any corrections.